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DISCLAIMER

The information in this manual is furnished for informational use only and subject
to change without notice. While every effort has been made to ensure that the
information contained in this user manual is accurate, up-to-date and reliable,
EVS Broadcast Equipment cannot be held responsible for inaccuracies or errors
that may appear in this publication.

IMPROVEMENT REQUESTS

Your comments will help us improve the quality of the user documentation. Do not
hesitate to send improvement requests, or report any error or inaccuracy on this

user manual by e-mail to doc@evs.tv.

REGIONAL CONTACTS

The address and phone number of the EVS headquarters are mentioned in the
Help > About menu in the user interface.

You will find the full list of addresses and phone numbers of local offices on the
EVS website, on the following page:

http://www.evs.tv/Europe,+*+Middle+East+Africa/English/Contact-us/Contact-
Us/Regional-contacts-new-/page.aspx/2038

USER MANUALS ON EVS WEBSITE

The latest version of the user manual, if any, and other user manuals on EVS
products can be found on the EVS download center, on the following webpage:

http://www.evs.tv/Europe,+*+Middle+East+Africa/English/Download-
center/page.aspx/1887
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What’s New

The following table describes the sections updated to reflect the new and modified
features on Epsio 1.60 (compared to Epsio 1.58).

In the user manual, the icon @ has been added on left margin to highlight
information on new and updated features.

Click the section number (or the description) in the table to jump directly to the
corresponding section.

Section Description

Section 1.2 Camera for live tools directly connected to IN2 of Epsio

Section 1.3.3 Server Information updated

Section 2.2.2 Default Tool setting on page 9.2 (F5) of the setup menu
on the Remote Panel

Section 2.2.4 Epsio Configurator: New user interface

Section 2.3.1 New preset main camera for calibrating the camera used
for live tools

Section 2.4.4 ‘Save’ and ‘Save As’ commands in the Chroma Key Edit

screen on the Remote Panel

Section 2.5 Definition and customization of the graphic suite

Section 2.6 Distinct duration for Fade In and Fade Out in Replay
settings

Section 3.1.2 Modifications in the Epsio main menu, and new Epsio

secondary menu, further to live tool integration.

Section 3.3 Creation of an animation with a live tool
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1. Overview

PRODUCT DESCRIPTION

Epsio is a graphics solution integrated into the MulticamLSM that allows the
operators to control graphic animations, such as offside line, graphic overlays,
arrows or circles, using the LSM Remote Panel.

It can be used with the EVS XT family servers and works with Multicam, from
version 10.2.30 onwards.

Before the event, the user performs the initial calibration, where the images of the
playfield are matched with predefined angles into the system. Based on this
calibration, Epsio is able to instantly and automatically recognize the playfield
during actions when the playfield is clearly visible on the video signal. The user
will also define the chroma key, which means the range of colors on the video
signal where the graphic animations will be incrusted.

The operator can then trigger the animation in a one-second operation, using the
jog wheel of the LSM Remote Panel.

The producer can automatically see a screenshot with the graphic animation, and
decide whether or not to play out the entire action with the effects.

A‘ Important
If you want to use the live tools in Epsio, you need to have the Live

Tools license installed in XSecure.

CABLING

The schema on the following page shows how the Epsio workstation and the EVS
server BNC cables should be connected:
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1.3 EPSIO USER INTERFACE

1.3.1 OVERVIEW

You will access Epsio by clicking the Epsio icon on the desktop, or via the Start
menu in Program Files > EVS Broadcast Equipment > Epsio > Epsio.

The following screenshot provides an overview on the Epsio user interface,
highlighting the various areas that will be explained in more details in the various
sections:

Operating Monitor Tabbed area

CALIB | TOOLS | CHROMA

Cameras

XT:1.1.20.24 (last cobmand 15:00:09)

Server Information Camera Angle List Zoom

For more information on the LSM Remote Panel, refer to the Multicam Operational
User Manual.
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x‘,?;)) Note
When the offside line mode is activated on the LSM Remote Panel, you
cannot use the mouse outside the operating monitor in Epsio.

To be able to move the mouse in the whole Epsio window, do one of the
following:

e In Epsio, press .l on the keyboard.

e Press RECORD on the LSM Remote Panel to go out of the offside line
mode.

1.3.2 OPERATING MONITOR

The operating monitor shows the video signal coming from the EVS server and
received on the Epsio connector IN1. It allows the users to visualize the
configuration action they perform, or the animations they create.

The image on the monitor is surrounded by a colored frame, which varies
depending on the tab open in the tabbed area on the right of the Epsio main
window:

e Blue frame when the Calibration tab is open
e Red frame when the Tools tab is open

e Green frame when the Chroma tab is open

1.3.3  SERVER INFORMATION AREA

The Server Information area is located at the left bottom of the Epsio main window
and provides the following information:

@« HD 1080i 50 PAL (In 1)
55 Epsio IP: 1.1.20.33 - XT: 1.1.20.24 (last command 14:07:21)

> Animations ON

The 1st line specifies:

e The video standard used by Epsio and the EVS server

e The Epsio IN connector that receives the video signal from the EVS server.
The 2nd [ine specifies:

e The Epsio and EVS server IP addresses

e The time when the last command was executed on the server.

When both systems are correctly connected, the icons in front of the first two lines
are greens.

The 3rd [ine informs the user whether the animation is visible or not.
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CAMERA ANGLE LIST

The Camera Angle list shows a thumbnail for each camera angle that has been
defined and/or calibrated. You can select a camera angle by clicking the
thumbnail. This Camera Angle list is particularly useful in the Calibration phase.

When the camera angle has only been created, but not calibrated yet, the
thumbnail shows a grey background and the virtual playfield.

When the camera angle has been calibrated, the thumbnail shows the frame
grabbed from the video signal.

ZOOM

The zoom area shows a zoomed display of the area around the mouse pointer on
the operating monitor. It mainly allows performing the calibration, as well as other
actions, in a very précised way.

TABBED AREA

The tabbed area gives access to the following tabs, in which you can configure
Epsio and select the animations you will perform:

e The CALIB tab allows the users to define and calibrate the camera angles.
See also the section 2.3.2 ‘Calibration Tab’, on page 12.

e The TOOLS tab allows the users to select the animations they want to perform,
and refine the settings for these animations.

See also the section 2.5.2 ‘Tools Tab’, on page 40

e The CHROMA tab allows the users to define the chroma key layer that will
define how the offside line animation will be displayed.

See also the section 2.4.5 ‘Chroma Key Tab in Epsio’, on page 34.
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2. Configuration

2.1 OVERVIEW

The configuration in order to use Epsio with an EVS server has to be performed in
the Epsio application or on the EVS server side (via the EVS menu and the LSM
Remote Panel), depending on the configuration step.

2.1.1 CONNECTION STEPS

Before you can actually configure Epsio, you first need to set up Epsio and the
EVS server to communicate with each other:

# Step Where? See section

1. Starting the appropriate EVS server EVS server 2.2.1
application

2. Activating the connection between Remote Panel 2.2.3

Epsio and the EVS server

3. Checking the video feeds Epsio 2.2.4

2.1.2 CONFIGURATION STEPS

Once Epsio and the EVS server are properly connected, you can perform the
actual configuration steps.

# Step Where? See section

1. Calibrating the cameras Epsio 2.3

2. Configuring the Chroma Key settings Remote Panel 2.4

or Epsio
3. Customizing and loading the graphic Epsio 2.5
suite
4, Defining the Replay settings Remote Panel 2.6
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SAVING AND MANAGING THE CONFIGURATION

The commands available in the the File menu allow you to save and manage the
configuration you will perform. The configuration, which includes the camera
calibration and the chroma key definition, is saved in a configuration file that is
made up of two .xml files:

o A file containing the playfield distances and all camera angle definitions.

This file is ‘name’.xml where <name> is the name the user gives to the
configuration when it is saved for the first time.

¢ A file containing the chroma key configuration.
This file is ‘name’.CK.

In the File menu, you have access to the following commands:

Command Use

New Use this command before you start a new calibration.

This creates a new empty configuration file that you can save
throughout the calibration process.

Load Use this command to point to and load an existing configuration file.
Save Use this command to save your calibration while you define it.
It is recommended to save the configuration after each calibration
step.
Save As Use this command if you want to save the open configuration file

into a new name, for backup purposes, or to start a new calibration
from an existing one.

The configurations are stored by default in the following location:

C:/Program Files/EVS Broadcast Equipment/Epsio/Config.
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2.2 CONNECTING EPSIO AND EVS SERVER

2.2.1 STARTING THE EVS SERVER APPLICATION

When using Epsio with an EVS server, you need to run a server application:

e with at least 2 recorder channels and 2 player channels

e in a Multicam LSM base configuration.

For more information on starting an EVS application, refer to the EVS Menu
section in the Technical Reference Software manual.

2.2.2 EPSIO SETTINGS ON REMOTE PANEL

The settings to activate the Epsio mode, and specify the default Epsio tool are
available on page 9.2 of the Setup menu. These settings are described below:

Setting

Possible
Values

Description

[F2] Offside
Line

On, Off
(default)

Activates the offside line feature, whatever
internal or external.

When the parameter is set to ‘On’, the External
Offside parameter is displayed.

[F3] External
Offside

On, Off
(default)

Enables the control of Epsio from the Remote
Panel.

When the setting is set to ‘Off’, the offside line
feature built in the EVS server is active. The
SHIFT+D key in the Operational menu gives
access to the Offside menu.

When the setting is set to ‘On’, the Epsio
application is active. The SHIFT+D key in the
Operational menu gives access to the Epsio
menu. The IP Address and Default Tool
parameters are displayed.

The EVS server will set this setting to ‘On’ if no
telestration option is installed on the server.

[F4] IP
Address

XXX, XXX, XXX. XXX

When the Epsio connection is enabled with the
External Offside parameter, the IP Address of
the Epsio workstation has to be entered in this
parameter to allow the communication between
the EVS server and the Epsio workstation.

[F5] Default
Tool

Offisde, Arrow,
Circle,
Graphics

When the Epsio connection is enabled with the
External Offside parameter, this parameter
specifies the tool to be activated by default in
the Epsio menu on the Remote Panel.
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ACTIVATING THE CONNECTION BETWEEN EPSIO AND THE
EVS SERVER

To activate the offside line mode and the external offside line mode, proceed as
follows:

1. From the Main menu, select Setup by pressing SHIFT + D to enter the Setup
menu.

2. Press the F9 key to go to the Special Effects settings, and then F0 to open
page 9.2.

3. Press F2 to access the Offside Line setting and rotate the jog dial to set it to
‘ON’.

This will display the External Offside setting.

4. Press F3 to access the External Offside setting and rotate the job dial to set
it to 'ON’. The EVS server will set this setting to ‘On’ if no telestration option
is installed on the server.

This will display the IP Address setting.

5. Enter the IP address of the Epsio workstation as follows:

After entering the number for an octet with the function keys, validate by
pressing ENTER on the LSM Remote Panel.

6. Press MENU twice to go out of the Setup menu.

7. Press SHIFT+D to enter the offside line mode.

The Epsio workstation should now be connected. In Epsio, the first two lines in the
Server Information area should have green icons, which shows that both systems
are correctly connected and using the same standard:

@« HD 1080i 50 PAL (In 1)
55 Epsio IP: 1.1.20.33 - XT: 1.1.20.24 (last command 12:48:55)

Animations OFF

For more information on this Server Information area, refer to the section 1.3.3
‘Server Information Area’, on page 5.

CHECKING THE VIDEO FEEDS

Once you have switched on the Epsio workstation for an event, you should check
that you correctly get the feeds before you launch the Epsio software. The Epsio
Configurator helps you detect and check the feeds.

To check the video feeds, proceed as follows:

1. Double click EpsioConfigurator.exe available in C:/Program
Files/EVS Broadcast Equipment/Epsio/Bin oron the desktop.

The Epsio Configurator opens:
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“a Epsio Configurator - V. 1.0.1.4 (30/06/10)

wideo Fovmat | HI & X xkern lock, Autko Refresh

2. In the Setup group box, select the Video Format you are working with and the
type of Genlock system you are using.

3. Click the Open button.

Epsio checks the format you have specified is compatible with the format used
by the EVS server.
Epsio automatically grabs and displays an image of the video signals delivered
to the IN connectors and sent from the OUT connectors.

4. As you check the incoming and outgoing signals, you can perform the following
actions to help you identify the signals:

o To check the incoming signals, you can click the Grab button to grab the
current image delivered to the incoming feeds.

o To check the output signal from the OUT1 connector, you can either
change the signal sent to OUT1 by selecting In 1, In 2, or Bars, or add the
PC time or a logo display to the output signal.

o To check the current output signal from the OUT 2 connector, you can click
the Snap button to refresh the video display corresponding to output 2.

5. When you have checked the incoming and outgoing video signals, click the
Apply button.

6. Click Exit.

1
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CALIBRATING THE CAMERAS

INTRODUCTION

In Epsio, calibrating the cameras consists of positioning a virtual playfield in a 3D
environment to match the position of the actual playfield used for a given event.
You calibrate the cameras in the Calibration tab in Epsio.

OFFSIDE LINE CALIBRATION

When you use the offside line tool, you usually calibrate two 16-meter cameras for
an event: a left-angle camera and a right-angle camera. However, Epsio allows
you to use other cameras.

You calibrate each 16-meter camera on two angles: looking at the goad area, and
at the central circle.

LIVE TOOLS CALIBRATION

When you use the live tools, you calibrate the camera that is directly connected to
Epsio via the IN2 Connector. For this physical camera, you will calibrate a main
camera in Epsio. The three angles (left, center and right) are automatically added
to the Camera Angle List when you add a main camera in the Calibration tab.

AA Important
Only calibrate your cameras when you have validated the camera

position, height and orientation. These should no longer change after the
calibration.

CALIBRATION TAB

OVERVIEW

The following table gives a short explanation on each area of the Calibration tab
displayed below:

Area Description

Camera Creation This area allows you to add cameras, and assign them to a
recorder channel on an EVS server.

See also the section ‘Camera Creation Area’, on page 14.

Current Camera This area allows you to perform several actions on the
selected camera.

See also the section ‘Current Camera Area’, on page 15.
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Area Description
General This area allows you to modify the default playfield size (105
meters by 68 meters), as well as to display and/or modify
the grid of the virtual playfield.
See also ‘General Area’, on page 17.
CALIB |TDDL5 CHROMA
Camera Cameras

Creation area

Current
Camera area

General
darea

13
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CAMERA CREATION AREA

Presets 16 Left 16 Right Main

=T Channel
&dd to the - @ add

This area allows you to add cameras, and assign them to a recorder channel on an
EVS server.

Field Description
@ add Buttons that allow the user to define a new camera in
] - the system. Several preset cameras are available:

e The Add button below the 16 Left label allows
adding a 16-meter left-angle camera.

It creates two cameras angles (goal and center).

e The Add button below the 16 Right label allows
adding a 16-meter right-angle camera.

It creates two cameras angles (goal and center).

e The Add button below the Main Label allows adding
a camera for the live tools.

It creates three camera angles (left, center, right).

e The Add button below the Free Preset label should
be used to create any other camera.

It creates one camera angle.

Field to associate the recorder channel of the EVS
server to the created camera. The field value is made
up as follows:

=T Channel A00 |

e The first letter is the camera letter on the server

e The last two digits correspond to the server net
number on the SDTI network.

By default, the A channel is assigned to the 16-meter
left camera, and the B channel is assigned to the to the
16-meter right camera.
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CURRENT CAMERA AREA

MName
Fosition

Qrientation

Suto

Snapshot

sdvanced

Bl - |

0.0 w400 Z:-15.0

Raoll: 0.00°

[ Goal area Detection

W central Circle Detection

—m— i6.06m

X) delete

This area allows you to perform several actions on the current camera. The
current camera is the one selected in the Camera Angle list. This is displayed in a
blue frame in the Camera Angle list.

Field

Description

monitor.

The camera name can only be modified using
the Rename button.

@

| Displays the name of the camera selected in
the Camera Angle list below the operating
Abc

Rename button used to rename the camera.

Position

DALl  Non-editable field that summarizes the

parameters for the camera position.

Orientation

Raoll: 0.26° Non-editable field that summarizes the

parameters for the camera orientation.

At [l Goal Area Detection Check box that allows the system to detect the

W central Circle Detection

goal area when the user creates an offside line
animation. When you calibrate a left or right
angle, tick this check box.

For the automatic detection to work properly,
the image should clearly display the goal area.

15
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Description

Auto [ Goal area Detection

W central Circle Detection

Check box that allows the system to detect the
central circle when the user creates an offside
line animation. When you calibrate a center
camera angle, tick this check box.

For the automatic detection to work properly,
the image should clearly display the central
circle.

snap

Snap Button used to grab a new image of the
playfield on which the calibration of the camera
will be based. It grabs the current frame on the
video input 1 (PGM1).

@ reset

Button used to reinitialize the display of the
virtual playfield for the selected camera.

Button used to delete the selected camera.

Advanced

EM - |

. 86.06m

Check box to display or hide the two fields
below used for fine-tuning the current camera
position.

Advanced

3 - |

. 86.06m

Field that allows selecting the position
parameter you want to modify among the
following ones:

e X axis: north/south axis to define the camera
position

e Y axis: east/west axis to define the camera
position

e Z axis: up/down axis to define the camera
position

e Pan: angle to define the horizontal
orientation of the camera on its position, in
this case from 85° to 125°

e Tilt: angle to define the vertical orientation
of the camera on its position, in this case
from 60° to 100°.

e Roll: angle to define the camera orientation
along its longitudinal axis, in this case from -
20 to +20°

e Orientation: mix of Y axis and pan, to
simulate a rotation around the center of the
playfield

Advanced

. 86.06m

Once the position parameter is selected, you
can change its value dragging the slider to the
right or left.
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GENERAL AREA

/E General

Length —_— N — 105.00 m

ufidth —m— 59.90 m

Show grid

Space

This area allows you to modify the size of the virtual playfield, and whether/how
grids will be displayed on the virtual playfield.

Field Description

Length Slider to modify the default playfield length (105 meters).
Width Slider to modify the default playfield length (68 meters).
Show Grid Check box to display or hide the grid on the virtual playfield
Space When the grid is displayed, the space slider makes it possible

to modify the line space in the grid.
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2.3.3 How 10O CALIBRATE THE CAMERAS

@ Note
The calibration steps explained in the sections below illustrate the
calibration of the two 16-meter cameras used with the offside line tool.
However, the same procedure applies to the calibration of the free
camera for the live tools.

Once Epsio is open, you calibrate the various cameras in the CALIB tab, in the
following way:

1. Add a virtual camera for each physical camera to be calibrated, by clicking
the Add button corresponding to the requested camera in the Creation area:

Presets 16 Left 16 Right Main

=T Channel
&dd to the - -

The camera angles to be calibrated for the corresponding camera preset are
added as frames including the virtual playfield in the Camera Angle list:

2. Using the Preview channel, make snapshots of the real playfield
corresponding to each calibration angle in the following way:

a.In the Camera Angle list in Epsio, click the camera angle to which you
want to associate a snapshot.

b. Pause on the requested frame in the preview channel.

18
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c. Click w in the Current area in Epsio.

For more information, refer to the section 2.3.4 ‘Good Snapshots of the
Playfield’, on page 20.

3. For each camera angle, perform a rough calibration, by matching four non-
contiguous virtual anchor points to the real position in the playfield as
follows:

e Right-click a virtual anchor point (crosses on the lines) on the requested
camera angle and drag it to the corresponding position on the real
playfield, then release.

A light blue line is drawn between the virtual point and the matched point on
the snapshot:

AT N Y

Once the fourth point has been matched, the virtual playfield is automatically
superimposed to the snapshot.

For more information on the four points to be matched, and on the possible
actions with the mouse, refer to the section 2.3.5 ‘Recommendations for
Matching the Virtual Playfield to the Real One’, on page 23.

4.  Adjust the playfield size if necessary:

e Check that touchlines are not too long or too small on the four calibration
angles, and if necessary adjust the playfield width.

e Check that the central circle is not too large or small on the two central
calibration angles, and it necessary adjust the playfield length.

5. Click the menu File > Save to save the configuration. The default location
where  configurations are stored is C:/Program Files/
EVS Broadcast Equipment/Epsio/Config.

The camera angles defined in Epsio are now associated to snapshots of the
real playfield and saved in a configuration file. You can load them back via
the File > Load menu. See also the section 2.1.3 ‘Saving and Managing the
Configuration’, on page 8.
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6. Load the test snapshots, and perform the necessary adjustments, by
repositioning only the anchor points initially matched in step 3.

For more information on the calibration tests, see the section 2.3.6 ‘Testing
your Calibration’, on page 24.

7. On a shot that includes the 16-meter line, and part of the central circle, add
virtual points for offside shots where playfield lines would not be visible.

For more information on additional virtual points, see the section 2.3.7
‘Adding Virtual Points’, on page 27.

GOOD SNAPSHOTS OF THE PLAYFIELD

INTRODUCTION

For each 16-meter camera used for the offside feature, you need to take two
snapshots corresponding to each camera angle:

e Goal area

e Central circle

For the main camera used for the live tools, you need to take three snapshots
corresponding to each camera angle:

o Left angle

e Center angle

e Right angle

Keep the following in mind when you select the frame you will use:

e A playfield is naturally curved, whereas the Epsio virtual field is made up of
straight lines.

e A very wide shot is very likely to distort the image, which will intensify the
curved effect of the field.
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SNAPSHOTS FOR THE GOAL AREA CALIBRATION

The snapshot for the goal area of the left or right 16-meter camera should show:

o the whole left or right penalty area (respectively) with 16-meter line, including
the goal area with the 6-meter line

e the goal line along the goal area,

e part of each touchline on both sides of the playfield.

‘A Important
The touchlines should be parallel to the horizontal borders of the frame,

and the zoom should keep the distortions of touchlines as low as
possible.

Figure 2: Good Snapshot for the calibration of the goal area with a right 16-meter camera

21
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SNAPSHOTS FOR THE CENTRAL CIRCLE CALIBRATION

The snapshot for the central circle of the left or right 16-meter camera should
show:

e the whole central circle (not the full central line),

e the 16-meter line of the left or right penalty area (respectively), and the penalty
arc.

Figure 4: Good Snapshot for the calibration of the central circle with a right 16-meter camera
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2.3.5

RECOMMENDATIONS FOR MATCHING THE VIRTUAL
PLAYFIELD TO THE REAL ONE

VIRTUAL POINTS TO BE MATCHED FOR EACH CAMERA ANGLE

The following screenshots show four virtual points you are advised to use for each
camera angle to perform an optimal calibration:

POSSIBLE ACTIONS USING THE MOUSE

Here are the possible actions you can perform in this step:
e To select a virtual point, right-click on it.
e To delete a virtual point, click on it.

e To add a virtual point, press CTRL + click on the virtual field at the position
where the point should be added.

e To remove a virtual point you have added, click on it.
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ADDITIONAL TIPS

Here are the following tips to help you in this step:

e Once you have selected a virtual point, you can adjust its position using the
arrows on your keyboard.

e The four anchor points you use to calibrate a camera angle should not be
aligned.

e Always match the points to the same edge of the lines.
e You can use more than 4 points to perform the calibration.

e |f the 2nd and 3rd tests of the goal area calibration for a given camera are
excellent, you can use the position parameters (x,y,z) of this camera angle for
the central circle calibration of the same camera.

TESTING YOUR CALIBRATION

GENERAL TEST
Once you have calibrated all your camera angles, it is recommended to test them
using test snapshots of the playfield.

A general and quick test consists of drawing an offside line, and rolling it over the
calibration shots, to ensure that the offside line matches the following lines of the
field:

e the 16-meter line
e the 6-meter line
e the half-way line

Systematic tests based on test snapshots are explained in details below.

TESTING THE GOAL AREA

1st Test
Using the same view as your calibration shot, take an offside shot.
Check that the 16-meter line and 6-meter line are correctly matched.

If necessary, reposition the faulty anchor points.
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2nd test

Move the camera to the bottom corner arch without changing the zoom.

R aiicciodal TSR

Check that the 16-meter line and 6-meter line are correctly matched.

3rd test

Move the camera back to the goal area, keeping the 6-meter and 16-meter lines.

All lines must match.

If the tests are not satisfactory, refine the calibration by matching several
calibration points again. Each time you modify your calibration, you need to
perform the tests again.

When you do not achieve perfect results using calibration points, you can modify
the advanced settings for the camera position in the Current area to fine-tune your
calibration. These parameters allow a global modification of the calibration for
each camera, taking into account the X, Y, Z position, as well as the orientation
with the pan, tilt and roll angles. See also the description of the Advanced group
box in the section ‘Current Camera Area’, on page 15.
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TESTING THE CENTRAL CIRCLE

All lines must be correctly matched on the calibration shot. Besides this, you
should test three additional test shots:

1st test

Using the same view as your calibration shot.

Check that the central circle is correctly matched, and that the borders of the half-
way line are correctly matched.

If necessary, reposition the faulty anchor points.

2nd test

Center the camera on the half-way line to see the whole line.

When you draw an offside line on this shot, the virtual line should touch both ends
of the half-way line. Due to the natural playfield curve, the offside line may not
fully correspond to the half-way line around the middle of the line.
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3rd test

Move and zoom the camera to view the 6-meter line, and part of the half-way line.

Use this test shot to add your additional virtual points.

2.3.7 ADDING VIRTUAL POINTS

During the calibration, it is recommended to create additional virtual points
outside the playfield, using the stadium geometry (first step of the terracing, static
banners around the field, and so on).

To add virtual points, you can use a shot similar to the snapshot used for the 3rd
calibration test of the central circle.

The additional virtual points will be used later on if you have to manually
reposition your virtual playfield to validate the field limits (See the section 3.2.2
‘How to Validate the Playfield Limits’, on page 49) with shots where no playfield
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CONFIGURING THE CHROMA KEY

GENERAL INFORMATION

CONCEPT OF CHROMA KEY

The chroma keying is a technique for compositing two images or frames together
in which a color (or a range of colors) from the main image (video signal) is
removed (or made transparent), revealing another image behind it. The key is the
image that punctures through the image of the video signal.

In Epsio, you select the green color of the playfield (or a range of green) and
replace it by the key layer. The key layer will define how the offside line animation
will be displayed:

e All that is white in the key layer will not be incrusted.
In the final result, the key is transparent and the main image will show.

o All that is black in the key layer will be incrusted with the offside line animation.
In the final result, the main image is covered by the offside line animation.

e The more an area is black, the more the incrusted material will show.

4

In summary, when you define the chroma key, you define the color or color range
in the video signal that will be replaced by the offside line animation.


http://en.wikipedia.org/wiki/Compositing
http://en.wikipedia.org/wiki/Color
http://en.wikipedia.org/wiki/Image
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2.4.2

IMPACT OF LIGHT CONDITIONS

As the chroma key depends on the light, it is recommended to configure the
chroma key 30 minutes before the match to get the closest to the light conditions
that will prevail during the match.

For a match during the day, you should perform two chroma key configurations:
one for light, one for dark, to allow you to cope with shadows on the playfield.

In case you have a bright light, but a large shadow across the field (for example
the top of the stadium roof structure), you can also make a chroma key matching
light and shadows, in which case the players would be under the graphics.

For a match during the night, you can configure a chroma key as soon as the sun
is down and the stadium lights are on.

RECOMMENDATIONS

You can define the chroma key:
e in the chroma key edit screen on the LSM Remote Panel

e in the CHROMA tag in Epsio.

It is recommended to configure the chroma key using the Remote Panel. For this
reason, we will provide minimal information on the chroma key definition using the
CHROMA tab in Epsio.

ACCESSING THE CHROMA KEY MENUS

ON THE LSM REMOTE PANEL

To access the Chroma Key edit screen on the LSM Remote Panel, proceed as
follows:

1. From the operational menu in PGM/PRV mode, press the SHIFT+D key to enter
the Epsio main menu:

Frerm ] Fme ]
Gz | | | | |

The Offside menu opens:

| | [ononar_] —
i | [ —] | |

2. In the Epsio menu, press SHIFT+B to enter the Chroma Key edit screen.

iChroma key Edit Screen
Fl: X F5: X Transition

F2: Y F6: Y Transition

(F3: Width F7: Black Level

§F4: Height F8: Toggle View

: |Auto | |Save | |Save As | |Quit |

[profile 2 | [profile 3 | [profile 4 |

You will configure the chroma key from this menu.
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IN EPSIO

In Epsio, you can configure the chroma key in the CHROMA tab:

Chroma-Key

mi103 113 wild H:ldo Tedlo Tl Black : &4

e
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243

CHROMA KEY PARAMETERS

You can create and manage up to four chroma key definitions from the LSM
Remote Panel, or in Epsio, using the chroma key profiles.

The various chroma key parameters allow you to define or refine a chroma key
profile.

The representation of the chroma key definition in a color space will help you
visualize the range of colors taken into account in the chroma key definition.

REPRESENTATION OF THE CHROMA KEY IN EPSIO

A YUV color space is displayed on the CHROMA tab in Epsio to represent the
color range selected in the chroma key:

I|:| Colar vi

The chroma key definition is represented as follows on the color space:

e The black box in the color space corresponds to the colors that are totally
removed on the chroma key layer (black).

e The colors between the black and white boxes in the color space correspond to
the transition color range, in other words to the colors that will be more or less
removed on the chroma key layer. The white box is clearly displayed in Epsio.

e The colors outside the white box in the color space correspond to the colors
that are not removed on the chroma key layer (white).

REPRESENTATION OF THE CHROMA KEY ON THE MONITOR

A YUV color space is displayed on the top left corner of the monitor to represent
the color range selected in the chroma key. It contains additional scales, with
‘sliders’ to reflect the hue, saturation and black level (or brightness) of the
selected color range. The grey box displayed on the color space represents the
selected color range.
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DEFINITION OF THE CHROMA KEY PARAMETERS

The chroma key parameters are explained in the table below:

Parameter

Description

RGB Hue Value Definition

X

Moves left and right the color range in the color space.

Y

Moves up and down the color range in the color space.

Tolerance Definition

Width (W)

Widens or narrows the color range on the X axis in the
space.

Height (H)

Widens or narrows the color range on the Y axis in the
space.

Transition Definition

X Transition (TX)

Widens or narrows (on the X axis) the color range that will
be more or less punctured when defining the key layer.

Y Transition (TY)

Widens or narrows (on the Y axis) the color range that will
be more or less punctured when defining the key layer.

Black Level

Adjusts the level of transparency of the graphic animation,
in other words defines how strong the animation will be
displayed.
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24.4

CHROMA KEY EDIT SCREEN ON THE REMOTE PANEL

INTRODUCTION

You define and manage the chroma key definition from the Chroma Key edit
screen. When you are in this screen, the Edit mode is directly active.

:Chroma key Edit Screen
Fl: X F5: X Transition
§F2: Y F6: Y Transition
(F3: Width F7: Black Level
:F4: Height F8: Toggle View
|Auto | ISave I ISave As | |Quit I

[profile 2 | [profile 3 | [profile 4 |

In addition, the color space is also displayed at the top left of the operator's PGM
monitor when you define the chroma key. It allows you to visualize the range of
colors taken into account in the chroma key definition.

For more information refer to the sections:

Section ‘Available Commands’ (page 33)

Section ‘Chroma Key Parameters’ (page 31)

Section ‘How to Configure a Chroma Key Based on an Automatic Chroma Key’
(page 37)

Section ‘How to Configure a Chroma Key Based on an Area Selected on the
Playfield (page 38)

AVAILABLE COMMANDS

The following table describes the various commands and parameters available on
the chroma key edit screen on the Remote Panel:

Field area or button Description

Chroma Key Parameters to define the color range taken into account
Parameters (F1-F7) in the chroma key definition.

For more information on the various parameters, refer the
section ‘Chroma Key Parameters’, on page 31.

Toggle View (F8) Toggles between the key layer view (white & black), and
image view (color) on the operator’'s PGM monitor.

Auto (SHIFT+A) Press this key to perform an automatic chroma key
definition that you can then save in one of the available
profiles.

Save (SHIFT+B) Press this key to save the changes into the currently
loaded profile (highlighted in black on the Chroma Key
edit screen.
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Save As (SHIFT+C)

Press this key, followed by a key corresponding to a

chroma key profile to save the currently loaded chroma
key definition under the selected chroma key profile.

Quit (SHIFT+D)

Press this key to leave the chroma key edit screen.

Profile 1 (A) to Profile

4 (D)

be saved.

Four profiles under which the chroma key definitions can

2.4.5 CHROMA KEY TAB IN EPSIO

TAB OVERVIEW

You can also refine the chroma key definition in the CHROMA tab in Epsio.

The following schema shows the various areas in the CHROMA tab.

Buttons

List

Adjustment
Sliders

34
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FIELDS AND COMMANDS IN THE CHROMA TAB

The following table describes the field boxes and buttons on the tab:

User Interface
Element

Description

Profiles area

EVS Profiles list

Lists the chroma key profiles available in the Chroma Key
edit screen of the LSM Remote Panel:

e Clicking the profile will load a preview of the chroma key
on the preview area.

e Double-clicking the profile will load the chroma key
parameters in the CHROMA tab and the chroma key
definition for the current image of PGM1 if you are in the
Chroma Key edit screen on the LSM Remote Panel. This
image will show in the Epsio operating monitor.

Preview Shows a preview of the chroma key profile selected in the
list.

Snap Button used to snap the current image from PGM1 and
loads it onto the operating monitor.

Load Button used to load the profile selected in the Settings
area.

Save Button used to save the chroma key values defined for the

chroma key profile loaded into the CHROMA tab.

Settings area

Color space

Shows the color range for the chroma key definition.

Also refer to the section ‘Chroma Key Parameters’, on
page 31.

Adjustment sliders

Each slider allows modifying one of the chroma key
parameter of the loaded chroma key profile.

Also refer to the section ‘Chroma Key Parameters’, on
page 31.

%‘,;3;)3 Note
When you are refining the Chroma key in Epsio, you can toggle between
the chroma key and the image showing the final incrustation by right-
clicking the mouse.
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2.4.6 METHODS AND RECOMMENDATIONS FOR THE CHROMA KEY
DEFINITION

METHODS

There are several ways to configure your chroma key.
This section will explain the two main methods:
e Defining a chroma key based on an automatically generated chroma key.

e Defining a chroma key based on an area selected on a playfield.

STEPS

In both methods, you need to go through the following steps:

1. Accessing the Chroma Key edit screen.

2. Generating the initial chroma key definition

3. Opening a chroma key profile (and load the initial chroma key)
4. Refining the initial chroma key definition
5

Saving the final chroma key definition in a profile.

RECOMMENDATIONS AND TIPS

In the Chroma Key edit screen, the F8 function allows you to toggle between the
chroma key layer (white/black display) and the representation of the final
incrustation on the video signal (color display).

It is recommended to:
e Use the chroma key layer to define the chroma key parameters from F1 to F6.

e Toggle to the final incrustation to refine the black level parameter (F7).

Q‘é} Note
If you cannot see the representation of the final incrustation, this means
you need the limits of your playfield could not be automatically validated.
You need to validate them manually. See the section 3.2.2 ‘How to
Validate the Playfield Limits’, on page 49.
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2.4.7

How To CONFIGURE A CHROMA KEY BASED ON AN
AUTOMATIC CHROMA KEY

The automatic chroma key is based the colors located within the virtual playfield.
For this reason, the virtual playfield must be correctly matched to the real
playfield on the snapshot you will use for the automatic chroma key.

To configure a chroma key based on an automatic chroma key, proceed as follows:

1.

10.

1.

12.

In the main operational menu, jog to an image of the real playfield that you will
use for the chroma key configuration.

Press SHIFT+D to enter the Epsio menu.

If the virtual playfield is not correctly matched to the real playfield, do one of
the following:

o Validate the field limits as explained in the section 3.2.2 ‘How to Validate
the Playfield Limits’, on page 49.

o Make an offside animation as explained in the section 3.2.3 ‘How to Create
an Offside Line Animation’, on page 50.

Press SHIFT+B to enter the Chroma Key edit screen.

iChroma key Edit Screen
EFl: X F5: X Transition
F2: Y F6: Y Transition
iF3: Width F7: Black Level
iF4: Height F8: Toggle View
IAuto | |Save I |Save As | |Quj_t |

|Profile 2 | |Profile 3 | |Profile 4 |

Press SHIFT+A (Auto) to generate an automatic chroma key on which you will
base your chroma key configuration.

Press SHIFT+C (Save As), then press A, B, C or D to select the profile in
which you want to save the automatic chroma key definition.

Press the key corresponding to the profile on which you have just saved the
automatic chroma key definition.

The automatic chroma key is loaded onto the operator’s preview monitor. You
can now refine it.

Press the function key corresponding to the parameter you want to modify and
jog the wheel to modify the parameter value as requested.

In this step, you can press F8 when you want to toggle between the key layer
and a representation of the final incrustation.

Repeat step 8 for all parameters you want to adjust.

Once you are satisfied with the chroma key definition, press SHIFT+C (Save

as), then press A, B, C or D to select the profile in which you want to save our
final chroma key definition.

Select the profile you want to use in your offside line animations. By default,
the last saved profile is active.

Press SHIFT+Q to quit and come back to the Epsio menu.

When you leave the Chroma Key edit screen, the activated profile is the one that
will be applied when you will create an offside line animation. The active profile is
displayed on a black background on the Chroma Key edit screen.
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How T0 CONFIGURE A CHROMA KEY BASED ON AN AREA
SELECTED ON THE PLAYFIELD

To configure a chroma key based on an area selected on the Playfield, proceed as
follows:

1.

9.

In the main operational menu, jog to an image of the real playfield that you will
use for the chroma key configuration.

Press SHIFT+D to enter the Epsio menu.

Press SHIFT+B to enter the Chroma Key edit screen.

iChroma key Edit Screen
EFl: X F5: X Transition
F2: Y F6: Y Transition
(F3: Width F7: Black Level
§F4: Height F8: Toggle View
|Auto | |Save | |Save As | |Quit |

[profile 2 | [profile 3 | [profile 4 |

Press A, B, C or D to select the profile on which you will configure your
chroma key.

Press F8 to display the video signal in color on the director’s preview.

Looking at the operator’'s preview, draw a rectangle with the mouse on the
image of the playfield to select an area that contains the basis color for your
chroma key.

Press the function key corresponding to the parameter you want to modify and
jog the wheel to modify the parameter value as requested.

In this step, you can press F8 when you want to toggle between the key layer
(black and white), and the representation of the final incrustation.

Once you are satisfied with the chroma key definition, press SHIFT+C (Save
as), then press A, B, C or D to select the profile in which you want to save
your final chroma key definition.

Select the profile you want to use in your offside line animations.

10. Press SHIFT+Q to quit and come back to the Epsio menu.

When you leave the Chroma Key edit screen, the activated profile is the one that
will be applied when you will create an offside line animation. The active profile is
displayed on a black background on the Chroma Key edit screen.
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2.5 ADDING AND CUSTOMIZING THE
GRAPHIC SUITE

M 2.5.1 GRAPHIC SUITE DEFINITION AND COMPONENTS

The graphic suite includes the graphic packs for the various tools you can use in
Epsio (offside, arrow, circle, graphics).

The graphic pack contains the definition of the components of a given Epsio
graphic tool, in other words this is the graphic chart of the tool.

A series of template graphic packs is available for each graphic tool. When the
graphic pack is loaded, its various targets (components) can be customized to
your needs.

The following schema gives you an overview on the elements included in a graphic
suite, and how they are hierarchically organized. The customization is performed
at the level of the target parameters. The schema does not show all possible
targets and target parameters for the available tools.

Targets Targets Targets Targets
Line Arrow Circle base Flag A

¢ J J ) ¢ J
(e )| Fomoren )_‘ craevorser ) ( Fags )
C )

Font for text
( Arrow color ) ( Text font
( Alpha ) ( Text size )
( Arrow size ) ( Text ratio )

To be able to perform an animation in Epsio, you need to define and load a
graphic suite. You will create, load and modify your graphic suite from the TOOLS
tab in Epsio. Once the graphic suite has been loaded in Epsio, the same suite is
automatically loaded each time Epsio is started.
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M 2.5.2 TooLs TAB

TAB OVERVIEW

CALIB TOOLS | CHROMA

New Action

Actions bution

. Open/Close
Graphics bf;m
Suite area
+ create f load '" save "save as
Pack area

Target area
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ACTIONS AREA

The following table describes the user interface elements in the Actions area:

Button Description

New Action Not applicable.

The fields in this area aim at creating the offside line
animations. As Epsio is used in combination with the
LSM Remote Panel, the offside line animations are
created on the Remote Panel.

GRAPHICS AREA

You will define your graphic suite in the Graphics area. The Graphics area is a
tabbed zone that you can display or hide. Once you have defined and loaded your
graphic suite, it is recommended to close the Graphics area since you should not
need to modify the graphic suite in the course of the event.

i The Edit button shows the tabbed zone in the
@ edit Graphics area.

When this zone is open, the Edit button
@ close becomes a Close button, used to hide the
tabbed zone.

GENERIC TAB

The Generic Tab is the sub-tab in the Tools tab where you define your graphic
suite. It contains several areas, named as follows:

e Suite Area
e Pack Area

e Target Area

SUITE AREA

The Suite area contains the various commands you will use to manage your
graphic suite:

Field/Button Description
+ Button to create a new graphic suite (.egs file)
Create from scratch.
f Button to select and load the graphic suite you
load will use in Epsio. You always need to load a

graphic suite to be able to use the various
graphic tools in Epsio.
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Field/Button Description

‘ Button to save the currently open graphic suite.
save

- Button to save the currently open graphic suite

‘SEVE d5 under a new name.

worldCup2010 Name of the loaded suite

PACK AREA

The Pack area allows you to select the tool and the graphic pack that you want to
edit.

Field/Button Description

Drop-down field to select the graphic tool for
which you want to define a graphic pack.

Click the Folder icon next to the Pack field to
select the graphic pack you want to work with
and assign to the above-mentioned tool.

If you click on the interrogation mark (?) next
to the Folder icon, you will have access to
additional information on the available graphic
packs.

TARGET AREA

Once you have selected the tool you want to edit, and the basic graphic pack you
want to use with this tool, you can refine the definition of the various components
included in the graphic pack in the Target area.

The components of a graphic pack are called ‘targets’. The parameters you can
customize will depend on the type of target you are editing:

Field/Button Description

Target Drop-down field to select the target you want to

edit in the selected graphic pack.
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General Parameters

The general parameters associated to the loaded target are displayed on the left.
These parameters are described in the table below.

Field/Button Description

Color g Specifies the color of the selected component.

Click the color frame to open the color palette,
and select the requested color.

&lpha Alpha @ 1 Slider that allows defining the transparency of
the Alpha layer of the selected component.

The Alpha field allows defining the
transparency for individual components,
whereas the black level of the chroma key
allows defining the general transparency for the
offside line animation.

Displays the result of the color selection (RGB)
for the loaded target.

Displays the result of the alpha channel
selection for the loaded target.

Alpha

Drop-down field to select the font to be used
for the text to be displayed.

Specific Parameters

Other more specific parameters associated to the loaded target are displayed in a
table on the right:

Billboard v
Billboard

a1

g :l
100.0
g :l

To edit these parameters, double-click the parameter. This opens a dialog box
similar to the following one, and in which you can modify the parameter value:
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Set Variable Arrow_5Size

M 2.5.3 How To CREATE A GRAPHIC SUITE

44

This procedure explains how to create and customize a graphic suite. If you want
to include default graphic packs in your graphic suite without customizing them,
skip the step 7.

To create a graphic suite, proceed as follows:

1.

In the TOOLS tab, Graphics area in Epsio, click the Edit radio button in the
Tools working mode area:

@) edit

The Generic tab is displayed in the lower part of the Tools tab:

In the Graphic area in Epsio, Generic tab, click the button.

In the Save As window, type the name you want to give to your graphic suite in
the File Name field, and click Save.

This creates a graphic suite (.egs file) to which you will associate the graphic
packs.

In the Generic tab, click

Arrow l

1

the arrow in the Tool drop-down field,

and select the tool which you want to assign a graphic pack to.

In the Generic tab, click the Folder icon next to the Pack drop-down field,
and select the default graphic pack (.egp file) on which you want to base your
customization.

More information on the various graphic packs is available as you click the
interrogation mark (?).

If you need to customize the loaded graphic pack, execute the following steps:

Target O o

Ao
a. Click the Target drop-down field Font for text
and select the component of the graphic pack you want to customize.

The parameters associated to the loaded target are displayed below the
Target field, or in the table on the right.

b. Edit the requested parameters referring to the section ‘Target Area’, on
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2.6

page 42, if necessary.
c. Repeat steps a and b for all the targets you want to customize.
d. Click the Save button regularly to save your changes.
7. Repeat the steps 4 to 6 for each tool available in Epsio.

8. When you have assigned, and possibly customized a graphic pack for all tools
available in Epsio, you can either:

o Save the changes in the graphic suite you have created clicking the Save
button

o Save the changes in another graphic suite clicking the Save As button.

The suite whose name is displayed at the top of the Generic tab is the loaded
graphic suite, in other words the suite that will be taken into account as you
create animations in Epsio.

DEFINING THE REPLAY SETTINGS

INTRODUCTION

The Replay settings are applied by default when you play back the offside line
animation once it has been created.

How TO MODIFY THE REPLAY SETTINGS

You can modify the Replay settings as follows:

1. From the main menu, press SHIFT+D (OFFSIDE) to enter the offside line
mode.

2. From the offside line mode, press MENU to display the Replay settings
screen:

Setup page

Feplay Zettings T el
[Fl]Pause Duration: 019 Frame (3]

[FE]Fade In Duration: 015 Frame(s)

[F3]Fade Dut Duration: 015 Frame(s3)
[Fa]Preroll Duration: 02 3econd(sz)
[FE]Default playback speed: 1003%

[Menu]Ouit [FO]Next

3. Select the function key related to the setting you want to modify.
4. Jog the wheel to set the requested value.

5. Press MENU to leave the Replay settings screen.
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REPLAY SETTINGS

The following table explains briefly the replay settings:

Setting Description

Pause Duration Duration of the pause before displaying the animation.

The pause duration can be between 0 and 300 frames. It
is recommended to have a minimum value of 3 frames.

Fade In Duration Duration of the fade effect at the beginning of the
animation.

The fade in duration can be between 0 and 300 frames.

Fade Out Duration Duration of the fade effect at the end of the animation.

The fade out duration can be between 0 and 300 frames.

Preroll Duration Number of seconds where the clip is paused before the
animation when the user presses the Last Cue button.

The Preroll value can be between 1 and 60 seconds.

Default Playback Default playback speed applied during the animation
Speed when the user presses the PLAY button.

The default playback duration can be between 0 and
300%.
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3. Creating Graphic
Animations

3.1 GENERAL INFORMATION

3.1.1 PREREQUISITES

Before you can create and play back an offside line or live animation in Epsio, you
must have performed the following configuration steps, which are described in the
Configuration chapter:

e Calibrating the cameras

e Configuring the chroma key and selecting a chroma key profile

e Creating, customizing and loading the requested graphic suite

e Defining the replay settings

3.1.2  OVERVIEW ON THE EPSIO MENU

From the main operational menu, press SHIFT+D to access the Epsio menu:

| | | | | | | |
| Arrow | | Circle I IGraphicsl

| | [ ] —
[ouw] [cm —] | |
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EPsio MAIN MENU

| | [omonax | I
|<—— Calibl ICalib ——>| | Detect |

The Epsio main menu contains the following commands:

Command Description

Graph Allows the user to display or hide the Epsio animation that
has been created. The Graph command is active when you
enter the Epsio menu.

Chromak Allows the user to enter the Chroma Key menu, in which you
can configure the chroma key definition.

Refer to the section 2.4.2 ‘Accessing the Chroma Key Menus’,
on page 29.

0SD Allows displaying or hiding the OSD information on the output
monitor. By default, the OSD information is displayed.

<-- Calib Allows moving to the previous calibration angle in the
Calibration tab of Epsio.

Calib--> Allows moving to the next calibration angle in the Calibration
tab of Epsio.
Detect Allows performing an automatic detection of the playfield

limits when one of the live tools is active. This option is only
available with the live tools.

SECONDARY MENU

The secondary menu contains the various tools you can use in Epsio.

To access or leave the secondary menu, press the MENU key on the Remote
Panel.

I | | | | | | |
oo | [rammies |

To activate a tool in the secondary menu, click the key corresponding to the
requested tool: Offside (A), Arrow (B), Circle (C), Graphics (D).



Epsio Version 1.60 — User's Manual Issue 1.60.C
EVS Broadcast Equipment — July 2010

3.2 CREATING AN OFFSIDE ANIMATION

3.21 REMOTE MENU WITH OFFSIDE FEATURE ACTIVE

If you want to create an offside line, you need to do the following before you enter
the Epsio menu:

e Have the offside line mode activated as default mode

e Position on the frame where you want to create an offside line animation.

From the main operational menu, press SHIFT+D to enter the Epsio menu:

| | | | | | | |
| Arrow | I Circle | |Graphics|

| === —
[oa] [ —] | |

The Epsio menu is displayed with the Offside tool active.

The Graph feature is active by default.
The Mark key is blinking red on the LSM Remote Panel.

The virtual playfield corresponding to the camera angle is displayed on the
director’s preview.

%‘,;3;)3 Note
If the playfield limits are automatically detected, the virtual playfield
lines are red. Otherwise, the virtual playfield lines will be white. In this
case, you first need to validate the playfield limits manually.

3.2.2 HoOw TO VALIDATE THE PLAYFIELD LIMITS

INTRODUCTION

Based on the calibration performed, the playfield limits are automatically detected
and matched to the virtual playfield when you enter the offside line mode. In this
case, the virtual playfield lines are displayed in red.

If the image on which you want to create your offside line is slightly blurred, or
does not display enough lines on the playfield for the automatic detection to work
properly, the virtual playfield will be made of white lines.

If the auto-detection of the playfield does not work (white lines) or if the virtual
playfield lines are not perfectly matched to the real playfield, you first have to
validate the playfield limits. This action consists of repositioning the virtual
playfield limits onto the real playfield limits.
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PROCEDURE

To validate the playfield limits, proceed as follows:

1. When you have entered the offside line mode, right-click one of the points on
the virtual field. This can be a virtual point you have added during the
calibration.

2. Drag the virtual field to match the real playfield.
3. Release the mouse.
4. Jog with the wheel to adjust the zoom.

The real playfield limits have been validated, and the virtual playfield lines are
now displayed in red on the monitor.

How TO CREATE AN OFFSIDE LINE ANIMATION

To create an offside line animation, proceed as follows:

1. In the operational menu, click A, B, C or D to select the camera that you want
to use to create the offside line animation:

e e | [rmsioe ]
fanz ] | | | |

2. Pause on the beginning of the offside sequence.

3. Press SHIFT+D to access the Epsio menu.

| Be=mml  Ra—
EEE | | | |

The GRAPH feature is automatically active (black background).

4. Looking at the director’s preview, position the offside line using the mouse or
the jog.

5. Press MARK. This has the following effects:

o The virtual playfield is removed on the operator’s preview.

o A snap is created on the director’s preview.

6. Go back to a position before the TC where you have marked the start of the
offside sequence:

o Press Last Cue to go back to the predefined pre-roll
o Jog to the requested position

7. To play the offside line sequence back with the offside line animation, do one
of the following:

o Press PLAY to play back at the predefined playback speed.
o Use the lever.

The director’'s PGM and the operator’s PRV are running and pause when it gets
to the beginning of the offside line animation. The pause duration depends on
the Pause Duration setting. The animation is then played.

8. After the animation has been played, you can use the lever or press PLAY to
carry on playing the record train.
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= 3.3

3.3.1

3.3.2

9. Press RECORD to go out of the Epsio menu.

If the operator keeps the Graph command active, the graphic will be played when
the clip will go on air.

If the director invalidates the offside line on his preview, the operator can press A
again to deactivate the Graph command. When the clip will go on air, the offside
sequence will be played out ‘clean’, without the offside line animation.

CREATING A LIVE ANIMATION

REMOTE MENU WITH A LIVE TOOL ACTIVE

To activate a live tool in the Epsio menu, you need to do the following:
1. Press MENU to enter the secondary menu.
2. Select the key corresponding to the requested live tool

3. Leave the secondary menu pressing again the MENU key:

I | | | | | | |
[Giroe | [omermice |

| | [Coromar ] I
|<—— Calibl ICalib ——>| | Detect I

The selected live tool is displayed on a black background, and the Detect

command is displayed in the main menu.

How 1O CREATE AN ARROW OR CIRCLE ANIMATION

When you are in the Epsio main menu, and have selected the live tool you want to
use, proceed as follows to create a live animation:

1. Looking at the Director’'s preview, press D (Detect) to refresh the automatic
field detection based on the loaded frame.

The virtual playfield is matched to the real playfield.

2. Position the mouse pointer where you want the arrow to start or the center of
the circle to be displayed.

The live tool is added to the A/V material.
3. You can then perform one of the following actions:

QO

Click again on the field with the mouse to reposition the animation.
b. Press A (Graph) to hide the animation.
c. Press the TAKE key to toggle between the arrow and the circle animation.

If the operator keeps the Graph command active, the graphic will be played when
the clip will go on air.
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If the director invalidates the offside line on his preview, the operator can press A
again to deactivate the Graph command. When the clip will go on air, the offside
sequence will be played out ‘clean’, without the offside line animation.

3.3.3 USING THE GRAPHICS TOOL IN EPSIO

As soon as the Graphics live tool is activated in the secondary menu, the graphic
defined in the graphic suite will be displayed continuously as soon as the user
comes back to the Epsio main menu, and as long as the Graph command is active.

52



EVS Broadcast Equipment
Liege Science Park

16, rue Bois St Jean
B-4102 Ougrée
Belgium

Corporate North & Latin America
Headquarters Headquarters

+32 4 361 7000 +1 973 575 7811

Evs To learn more about EVS go to www.evs.tv

Asia & Pacific
Headquarters

+852 2914 2501

.”///

Instant Tapeless TechnOlogy

Other regional offices
available on

www.evs.tv/contact

71N

N



	Copyright
	Disclaimer
	Improvement Requests
	Regional Contacts
	User Manuals on EVS Website
	1. Overview
	1.1 PRODUCT DESCRIPTION
	1.2 CABLING
	1.3 EPSIO USER INTERFACE
	1.3.1 Overview
	1.3.2 Operating Monitor
	1.3.3 Server Information Area
	1.3.4 Camera Angle List
	1.3.5 Zoom
	1.3.6 Tabbed Area


	2. Configuration
	2.1 OVERVIEW
	2.1.1 Connection Steps
	2.1.2 Configuration Steps
	2.1.3 Saving and Managing the Configuration

	2.2 CONNECTING EPSIO AND EVS SERVER
	2.2.1 Starting the EVS Server Application
	2.2.2 Epsio Settings on Remote Panel
	2.2.3 Activating the Connection Between Epsio and the EVS Server
	Checking the Video Feeds

	2.3 CALIBRATING THE CAMERAS
	2.3.1 Introduction
	Offside Line Calibration
	Live Tools Calibration

	2.3.2 Calibration Tab
	Overview
	 Camera Creation Area
	Current Camera Area
	General Area

	2.3.3 How to Calibrate the Cameras
	2.3.4 Good Snapshots of the Playfield
	Introduction
	Snapshots for the Goal Area Calibration
	Snapshots for the Central Circle Calibration

	2.3.5 Recommendations for Matching the Virtual Playfield to the Real One
	Virtual Points to be Matched for Each Camera Angle
	Possible Actions Using the Mouse
	Additional Tips

	2.3.6 Testing your Calibration
	General Test
	Testing the Goal Area
	1st Test
	2nd test
	Move the camera to the bottom corner arch without changing the zoom.
	3rd test

	Testing the Central circle
	1st test
	2nd test
	3rd test


	2.3.7 Adding Virtual Points

	2.4 CONFIGURING THE CHROMA KEY
	2.4.1 General Information
	Concept of Chroma Key
	Impact of Light Conditions
	Recommendations

	2.4.2 Accessing the Chroma Key Menus
	On the LSM Remote Panel
	In Epsio 

	2.4.3 Chroma Key Parameters
	Representation of the Chroma Key in Epsio
	Representation of the Chroma Key on the Monitor
	Definition of the Chroma Key Parameters

	2.4.4 Chroma Key Edit Screen on the Remote Panel
	Introduction
	Available Commands

	2.4.5 Chroma Key Tab in Epsio
	Tab Overview
	 Fields and Commands in the CHROMA Tab

	2.4.6 Methods and Recommendations for the Chroma Key Definition
	Methods 
	Steps
	Recommendations and Tips

	2.4.7 How to Configure a Chroma Key Based on an Automatic Chroma Key
	2.4.8 How to Configure a Chroma Key Based on an Area Selected on the Playfield 

	2.5 ADDING AND CUSTOMIZING THE GRAPHIC SUITE
	Graphic Suite Definition and Components
	Tools Tab
	Tab Overview
	Actions Area
	Graphics Area
	Generic Tab
	Suite Area
	Pack Area
	Target Area
	General Parameters
	Specific Parameters


	How to Create a Graphic Suite

	2.6 DEFINING THE REPLAY SETTINGS
	Introduction
	How to Modify the Replay Settings
	Replay Settings


	3. Creating Graphic Animations
	3.1 GENERAL INFORMATION
	3.1.1 Prerequisites
	3.1.2 Overview on the Epsio Menu
	Epsio Main Menu 
	Secondary Menu


	3.2 CREATING AN OFFSIDE ANIMATION
	3.2.1 Remote Menu with Offside Feature Active
	3.2.2 How to Validate the Playfield Limits
	Introduction
	Procedure

	3.2.3 How to Create an Offside Line Animation

	CREATING A LIVE ANIMATION
	3.3.1 Remote Menu with a Live Tool Active
	3.3.2 How to Create An Arrow or Circle Animation
	3.3.3 Using the Graphics Tool in Epsio



